Mercury WinRunner Installation Guide, Version 9.2

This document, and the accompanying software and other documentation, is protected by U.S. and international copyright laws, and may be used only in accordance with the accompanying license agreement. Features of the software, and of other products and services of Mercury Interactive Corporation, may be covered by one or more of the following patents: United States: 5,511,185; 5,657,438; 5,701,139; 5,870,559; 5,958,008; 5,974,572; 6,137,782; 6,138,157; 6,144,962; 6,205,122; 6,237,006; 6,341,310; 6,360,332; 6,449,739; 6,470,383; 6,477,483; 6,549,944; 6,560,564; 6,564,342; 6,587,969; 6,631,408; 6,631,411; 6,633,912; 6,694,288; 6,738,813; 6,738,933; 6,754,701; 6,792,460 and 6,810,494. Australia: 763468 and 762554. Other patents pending. All rights reserved.

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software Documentation is a “commercial item” as defined at 48 C.F.R. 2.101 (October 1995). In accordance with 48 C.F.R. 12.212 (October 1995), 48 C.F.R. 27.401 through 27.404 and 52.227-14 (June 1987, as amended) and 48 C.F.R. 227.7201 through 227.7204 (June 1995), and any similar provisions in the supplements to Title 48 of the C.F.R. (the “Federal Acquisition Regulation”) of other entities of the U.S. Government, as applicable, all U.S. Government users acquire and may use this Documentation only in accordance with the restricted rights set forth in the license agreement applicable to the Computer Software to which this Documentation relates.

Mercury, Mercury Interactive, the Mercury logo, the Mercury Interactive logo, LoadRunner, WinRunner, SiteScope and TestDirector are trademarks of Mercury Interactive Corporation and may be registered in certain jurisdictions. The absence of a trademark from this list does not constitute a waiver of Mercury’s intellectual property rights concerning that trademark.

All other company, brand and product names may be trademarks or registered trademarks of their respective holders. Mercury disclaims any responsibility for specifying which marks are owned by which companies or which organizations.

Mercury provides links to external third-party Web sites to help you find supplemental information. Site content and availability may change without notice. Mercury makes no representations or warranties whatsoever as to site content or availability.

Mercury Interactive Corporation
379 North Whisman Road
Mountain View, CA 94043
Tel: (650) 603-5200
Fax: (650) 603-5300
http://www.mercury.com

© 1993-2007 Mercury Interactive Corporation, All rights reserved

If you have any comments or suggestions regarding this document, please send them by e-mail to documentation@mercury.com.
Table of Contents

Chapter 1: Before You Install ................................................................. 5
  System Requirements .......................................................................... 6
  Upgrading from a Previous Version .................................................... 7
  Choosing the Installation and License Type ....................................... 8

Chapter 2: Installing WinRunner .......................................................... 10
  Running a Standalone or Network Installation .................................... 11
  Running a Workstation Installation .................................................... 30
  Using a Local Network Drive for Updates .......................................... 32
  Setting Up a Silent Installation ........................................................... 35
  Modifying DCOM Permissions to Enable Remote WinRunner Execution .................................................. 40

Chapter 3: Working with WinRunner Licenses ....................................... 48
  About Working with WinRunner Licenses .......................................... 49
  Understanding Your WinRunner License ............................................ 50
  Installing WinRunner Licenses ........................................................... 52
  Requesting a Seat License Code ......................................................... 53
  Activating a Seat License Code ........................................................ 55
  Changing the License Type ............................................................... 60
  Setting the LSHOST or LSFORCEHOST Variable ............................ 61
  Working with Commuter Licenses ....................................................... 63

Chapter 4: Configuring Visual Basic Support ....................................... 75
  Configuring Visual Basic 5.0 Support ................................................. 75

Chapter 5: Enabling Table Contents Checks
  for an ActiveX Control ..................................................................... 77

Chapter 6: Configuring WinRunner to Work
  with Embedded Browser Controls ..................................................... 79

Chapter 7: Adding WinRunner Features ............................................. 80

Chapter 8: Uninstalling WinRunner .................................................... 83
Table of Contents
Welcome to WinRunner, the Mercury enterprise functional testing solution. This guide describes everything you need to know to install WinRunner on a standalone computer or on a network. It describes the WinRunner package contents system configuration, registration procedures, how to choose a license type, and how to run the setup program.

Before you begin to install WinRunner, please review the following pre-installation information.
System Requirements

To successfully run WinRunner, you need the following minimum system requirements:

**Computer/Processor**  
An IBM-PC or compatible with a Pentium III or higher microprocessor.

**Memory**  
128 MB of RAM.

**Disk Space**  
50 MB of free disk space for a compact installation, or 140 MB for a typical or complete installation.

You may require an additional 20 to 40 MB on the drive where Windows is installed, depending on the shared components already installed on the machine.

An additional 10 MB of free disk space is required during the installation process for a compact installation, or 90 MB for a typical or complete installation.

**Operating System**  

**Display**  
Monitor with resolution of 800 x 600 or higher, and a minimum color depth of 256 colors.

**Browser**  
Microsoft Internet Explorer 6 or Microsoft Internet Explorer 7 (required).

---

*Note:* Performance has not been optimized for the minimum system configuration. For best performance, your system should be configured using higher than the minimum levels.
Upgrading from a Previous Version

You can install a standalone version of WinRunner over a previous version. Note that any changes made to the tests or any other files in the \lib directory will be overwritten. However, the existing \lib directory will be backed up as \lib.bak. Note that if \lib.bak already exists, the existing \lib directory will not be backed up. You should separately save any files you added or changed manually before installing WinRunner 9.2 over a previous WinRunner installation. Configuration changes made in the wrun.ini file will not be overwritten when installing WinRunner 9.2.

You cannot install WinRunner over WinRunner 2000 or WinRunner EURO. You must uninstall WinRunner 2000 or WinRunner EURO before installing WinRunner 9.2. For more information, see “Uninstalling WinRunner” on page 83.

To use WinRunner 9.2, you need a seat or concurrent license code. If you already have a license code, but you are upgrading from WinRunner version 7.01 or earlier (or 7.0 or earlier for European customers), you need a new license code. Request your license code from the Mercury Customer Support Web site at: http://support.mercury.com/license.

For more information on installing seat licenses, see “Working with WinRunner Licenses” on page 48. For more information on installing concurrent licenses, refer to the Mercury Functional Testing Concurrent License Server Installation Guide.

Note: When upgrading to WinRunner 9.2 from a version of WinRunner earlier than 6.0, make sure to upgrade to TestDirector 6.0 or later or to Quality Center, or install any software that installs ODBC 4 on another machine.
Choosing the Installation and License Type

Before you install WinRunner, you need to decide which installation type and license type you plan to use.

Choosing a License Type

When installing WinRunner for the first time, you must choose whether to install WinRunner with a seat or concurrent license. A seat license is a local license that can be used only on your computer. A concurrent license enables a given number of users to work concurrently. To use a concurrent license, your organization must have a Mercury Functional Testing Concurrent License server installed.

For more information on license types and an overview of the procedure for installing each license type, see “Understanding Your WinRunner License” on page 50 and “Installing WinRunner Licenses” on page 52.

Choosing an Installation Type

During the installation you must decide whether to install WinRunner on your computer as a:

➤ **Standalone installation.** An independent installation. You run the complete setup program and can select the installation options you want for your computer.

---

**Note:** You can also record your standalone installation to enable other users to perform a silent installation with an identical configuration. For more information on silent installations, see “Setting Up a Silent Installation” on page 35.
Before You Install

➤ **Network installation.** A WinRunner configuration that enables users to run a simplified workstation installation based on the options and features you select during the installation process. Note that, by default, the network installation does not enable you to use WinRunner from the computer on which you install it. If you want to use WinRunner on that computer, select **Network installation and add shortcuts to your Start menu** on the Installation Type screen during installation.

---

**Note:** You cannot install the Java Add-in on a network installation of WinRunner.

---

➤ **Workstation installation.** A simplified installation based on a network installation. When you install a workstation installation, only a few configuration files and shortcut icons are installed on your computer. To work with a workstation installation, you must ensure that a network installation of WinRunner is available on the network. The WinRunner software is located on the network computer, accessible via the installed shortcuts in your **Start** menu. When you run WinRunner from your workstation, changes you make in configuration dialog boxes are saved on your computer so that your customization preferences are set automatically each time you run WinRunner from your computer.
Installing WinRunner

Before installing WinRunner, you must know which type of installation you want to run and which type of license you want to install. For more information, see “Understanding Your WinRunner License” on page 50, and “Choosing the Installation and License Type” on page 8.

**Important upgrade information:** If you are upgrading from WinRunner 7.5 (or from WinRunner 7.01 for European customers) or later, you can continue to use your existing license code. For earlier versions of WinRunner, you must contact Mercury customer support to receive a new license code as described in “Working with WinRunner Licenses” on page 48, and in the *Mercury Functional Testing Concurrent License Server Installation Guide.*

This section describes:

➤ Running a Standalone or Network Installation
➤ Running a Workstation Installation
➤ Using a Local Network Drive for Updates
➤ Setting Up a Silent Installation
➤ Modifying DCOM Permissions to Enable Remote WinRunner Execution
Running a Standalone or Network Installation

Use the following procedure to install a WinRunner standalone or network installation.

If you are performing a network installation, follow the procedure below to install WinRunner on the network, and then run the workstation installation on each user workstation as described on page 30.

To run a standalone or network WinRunner installation:

1. Insert the CD-ROM into the CD-ROM drive. If the CD-ROM drive is on your local computer, the WinRunner Setup window opens. If you are installing from a network drive, connect to (map) the drive. Double-click autorun.exe in the root folder of the CD-ROM. The Setup window opens.
Installing WinRunner

➤ To view the WinRunner release notes, click Open Readme File.
➤ To browse the folders on the WinRunner Installation CD-ROM, click Browse this CD.
➤ To view an overview of WinRunner, click View a Quick Preview of WinRunner.
➤ To review the list of new WinRunner features, click What’s New.

---

**Note:** You must be logged on with administrator privileges to install WinRunner.

---

2 Click **Install WinRunner**. The WinRunner Setup splash screen and the Setup progress bar open.

If a previous version of WinRunner is already installed on your computer, the setup program uses the license settings from your current installation. If you want to change the license type, see “Changing the License Type” on page 60. Proceed to step 3.

If you are installing WinRunner for the first time, the License Type screen opens.

---

**Note:** The license type screen opens only if you run the installation from the Setup window (using autorun.exe). It does not open when running the installation from setup.exe.
Choose a license type.

➤ **Seat license.** A license that is specific to the computer on which it is installed. This license includes a 14-day period during which you must contact Mercury to obtain a permanent seat license.

➤ **Concurrent license.** A license server on the network regulates the number of concurrent WinRunner users. Each license entitles the organization to one additional concurrent user.

**Note:** Before you install WinRunner with a concurrent license, you, or the system administrator, must install a license server on the network from the Mercury Functional Testing Concurrent License Server CD-ROM in the WinRunner package. The concurrent license is purchased separately from Mercury and installed on the network license server. For information on installing a concurrent license server on the network, refer to the *Mercury Functional Testing Concurrent License Server Installation Guide.*
Installing WinRunner

For more information on license types, see “Understanding Your WinRunner License” on page 50. If you are not sure which type of license to install, contact your system administrator or your local Mercury representative.

Click OK. The Software License Agreement screen opens.

3 Read the agreement. To install WinRunner, you must accept the terms of the license agreement by clicking Yes. If you click No, the setup program will close.

4 In the Registration Information screen, type your name, the name of your company, and a WinRunner maintenance number. This number can be found in the Maintenance Pack Number envelope or on the bill of lading you received when you purchased WinRunner.

The maintenance number replaces what was formerly a serial number for each purchased copy of WinRunner. Note that there is a single maintenance number for each team of users.
The maintenance number, which identifies the customer, determines what features your license supports and how many licenses are generated for a concurrent license.

Click **Next**. The Registration Confirmation screen opens.

**5** Click **Yes** to confirm the registration information. The Installation Type screen opens.

**6** Select an installation type.

You can choose from:

➤ **Standalone Installation**. Installs WinRunner on a hard disk of your local computer.

➤ **Network Installation**. Installs WinRunner files that enable other users to run a simplified workstation installation and to run WinRunner on their computer using the software installed on your network computer.

➤ **Network Installation and add shortcuts to your Start menu**. Installs a network installation as described above and adds workstation shortcuts to your Start menu so that you can run WinRunner from the computer on which you installed the Network installation.
Installing WinRunner

Notes:

You cannot install a network installation over a previous version of WinRunner. When performing a network installation of WinRunner, either remove installations of previous versions first, or install the network installation in a different location.

You cannot install the Java Add-in on a network installation of WinRunner. If you want to work with the Java Add-in, select **Standalone Installation**.

For more information on installation types, see “Choosing the Installation and License Type” on page 8. If you are not sure which type of installation to choose, contact your system administrator.

7 Click **Next**. The Setup Type screen opens.
Choose the type of installation: **Typical**, **Compact**, or **Custom**.

➤ **Typical** installation. Installs commonly used program files, including online documentation and samples, Unified Report, and add-in support for PowerBuilder, Visual Basic, ActiveX, and WebTest environments. Note that you can choose which add-ins to load at the beginning of each WinRunner session. For additional information on loading add-in support, refer to the *WinRunner User’s Guide*.

➤ **Compact** installation. Installs only the required WinRunner program files, without online documentation, samples, Unified Report, and add-in support for PowerBuilder, Visual Basic, ActiveX, and WebTest environments.

➤ **Custom** installation. Enables you to select which features to install.

---

**Note:** When you install a standalone installation of WinRunner, Microsoft ODBC 4 is installed on your computer.

---

Click **Next**. If you chose a **Typical** or **Compact** installation, proceed to step 9.
Installing WinRunner

8 If you chose a **Custom** installation, the Select Features screen opens. Select the features you want to install.

You can install all features or you can select to install only specific features or add-ins. Choose from:

- **WinRunner.** Installs the basic WinRunner program. The WinRunner feature must be installed to install any of the other features listed.

- **Unified Report.** Enables you to view WinRunner test results in an HTML, QuickTest-style report.

---

**Note:** If you want to call WinRunner tests from QuickTest Professional 6.5 or later and view detailed results of the WinRunner events, you must install this feature.

---

- **Samples.** Includes a collection of sample WinRunner tests.

- **Online Documentation.** Contains several Help and PDF documents that help you learn and take full advantage of all WinRunner features and capabilities.
Installing WinRunner

➤ The following add-ins:
  ➤ Visual Basic
  ➤ PowerBuilder
  ➤ ActiveX Controls
  ➤ WebTest

In this screen, you can also specify the Destination Folder for the WinRunner installation. You can accept the default location or you can enter or browse to a new folder location.

To check the space available on the specified disk drive, click Disk Space.

Click Next and proceed to step 10.

9 If you chose a Typical or Compact installation, the Choose Destination Location screen opens. Click Browse to specify the destination folder or accept the default folder. To check the space available on a disk drive, click Disk Space.

Click Next. The Update Features screen opens.
You can check the Mercury Web site for updated features.

Select one of the following options:

➤ Select **Yes** to check the Mercury Web site for updated features.

➤ Select **No** if you want to install the features from the CD-ROM without checking for updated features.

➤ Select **Use local update folder** only if you know that updated features have already been downloaded to a folder on your local network. For more information on this option, see page 32.

Click **Next**.

If you select **Yes** in the Update Features screen, the installation checks the Mercury Web site for updated features. If there are features on the Web site that are newer than the corresponding features on the CD-ROM, setup prompts you to overwrite the CD-ROM features with the features found on the Web site. If no newer features are found on the Web site, then setup installs all features from the CD-ROM.
11 If you are installing WinRunner over a previous WinRunner installation, the Install/Reinstall Features screen opens.

➤ To reinstall existing features, select the Reinstall check box and decide whether to reinstall all existing features or only features with newer versions.

➤ To install features that are not yet installed, select Install all new features.

Click OK. If you selected Network Installation and add shortcuts to your Start menu in the Installation Type screen in step 6, proceed to the next step. Otherwise, proceed to step 13.
Installing WinRunner

12 If you selected **Network Installation and add shortcuts to your Start menu** in the Installation Type screen in step 6, the Choose Local WinRunner Folder screen opens. Select a location for the local WinRunner folder. This folder enables you to configure WinRunner to meet your specific testing requirements, while running a shared version over the network.
13 Click Next. The Choose WinRunner Temporary Folder screen opens.

Choose the location of your WinRunner temporary folder.

14 Click Next. The Select Program Folder screen opens.
Select or enter the program folder for the WinRunner icons.

15 Click **Next**. The Start Copying Files screen opens.

Review the installation settings you selected (displayed in read-only format). If you want to select different settings, click **Back**. If you are satisfied with the settings, click **Next**.

The installation process begins. To pause or quit the installation process, click **Cancel**.
**16** If you installed Visual Basic support and/or online documentation, the Mercury Setup screen opens when the installation process finishes.

Read the information on the screen and click **Next**. The License Information screen opens.
Read about the type of license you installed.

➤ **Seat license.** Each WinRunner computer requires its own license. The first time WinRunner is installed on a computer, it includes a 14-day demo license. During this time period you should contact Mercury to receive a permanent license for your computer. You can install the permanent license when you start WinRunner or from the WinRunner Help menu. For additional information, see “Working with WinRunner Licenses” on page 48.

---

**Note:** Do not change the date on a computer running WinRunner with a demo license.

---

➤ **Concurrent license.** A license server on the network regulates the number of concurrent WinRunner users. This enables you to run WinRunner on any computer on your network. It requires installing a concurrent license server and a concurrent license from the Mercury Functional Testing Concurrent License Server CD-ROM in the WinRunner package. For additional information, refer to the *Mercury Functional Testing Concurrent License Server Installation Guide*.

Click **Next.** The Registration Information screen opens.
18 Read the information about Mercury Customer Support.

If you register, you receive:

➤ access to Mercury's award-winning Customer Support Web site
➤ notification of new product releases and upgrades
➤ membership to Mercury’s worldwide community of testers

To register now, confirm that the Register now check box is selected. Click Next. Your browser opens to the Mercury Customer Support site (http://support.mercury.com). Follow the directions on the Customer Support site.

To register at a later time, clear the Register now check box.
19 Click **Next** to finish your WinRunner installation. The Setup Complete screen prompts you to restart your computer.

![Setup Complete Screen]

20 Click **Finish** to complete the setup process.

---

**Note:** It is strongly recommended that you restart your computer as soon as possible. Delaying the system restart could result in unexpected system behavior.

---

21 If you installed a network installation of WinRunner, run a workstation installation on all workstations. For more information, see “Running a Workstation Installation” on page 30.
After WinRunner is successfully installed, you can perform the following:

➤ To read last-minute information about WinRunner, choose **Start > Programs > WinRunner > Read Me**. The Readme file opens in Microsoft Wordpad.

➤ To view the WinRunner documentation in PDF format, you must have Acrobat Reader 4.0 or later installed. To view online books, choose **Start > Programs > WinRunner > Documentation > Printer-Friendly Documentation**.

➤ To start WinRunner, choose **Start > Programs > WinRunner > WinRunner**.

### Adding Features to a Network Installation

If you want to enable workstation installations to work with additional WinRunner add-ins, install the add-ins on your network installation before running the workstation installations.

If you install additional features from the WinRunner CD or additional external WinRunner add-ins on the network installation after you complete the workstation installations, you must uninstall WinRunner from all workstation installations and then run the workstation installations again to update each workstation with the new set of available features and add-ins.

Note that if you installed a WinRunner workstation installation on the Network installation computer (by choosing **Network Installation and add shortcuts to your Start menu** during the original installation), you must uninstall and reinstall that workstation installation as well to get the new features and add-ins.

**Note:** The WinRunner Java Add-in is not supported for Network and Workstation installations.

For information on installing additional features from the WinRunner CD, see “Adding WinRunner Features” on page 80. For information on installing external add-ins, refer to the installation guide for your WinRunner add-in.
Running a Workstation Installation

A workstation installation should be performed for each user running WinRunner from the network. This installation can be performed only after the network installation is successfully completed, including all add-in installations. For more information, see “Running a Standalone or Network Installation” on page 11 and “Adding Features to a Network Installation” above.

Note: Do not install WinRunner add-ins directly on a workstation installation. When you install the workstation installation, all add-ins that are already installed on the network installation are automatically made available to the workstation installation.

If additional features from the WinRunner CD or additional WinRunner add-ins are installed on the network installation after you complete the workstation installation, you must uninstall your current workstation installation and then run the workstation installation again to update your workstation with the new features or new set of available add-ins.

To run a workstation installation:

1 Map to the network drive where the network installation is installed.
2 Click Start > Run.
3 Type <network installation_folder>\setup\setup.exe and click OK. The WinRunner setup program starts. The WinRunner Setup screen and the Setup progress bar open. Then the software license agreement opens.
4 Read the agreement. To install WinRunner, you must accept the terms of the license agreement by clicking Yes. If you click No, the setup program will close.
5 In the Registration Information dialog box, type your name and click Next.
6 In the Registration Confirmation screen, click Yes to confirm the registration information.
7 Confirm the Workstation Installation message and click Next.
8 Define the location for the local WinRunner folder and click Next.

Note: The WinRunner folder on your hard drive is used to store configuration files you create during the testing process. Configuration files in this folder override configuration files of the same name on the network, so that you can configure WinRunner to your specific testing requirements.

9 Select the location of your WinRunner temporary folder. Setup updates and installs system files. Click Next.

10 Select the program folder for the WinRunner icons and click Next.

11 Restart your computer. The WinRunner program folder is added to your Start menu.

Notes:

If you try to start WinRunner before restarting your computer, WinRunner will not run properly.

After restarting your computer, you must log in (for the first time) with the same login name that was used when installing WinRunner.

After WinRunner is successfully installed, you can perform the following:

➤ To read last minute information about WinRunner, choose Start > Programs > WinRunner > Read Me. The Readme file opens in Microsoft Wordpad.

➤ To view the WinRunner online (PDF) books, you must have Acrobat Reader 4.0 or later installed. To view online books, choose Start > Programs > WinRunner > Documentation > Printer-Friendly Documentation.

➤ To start WinRunner, choose Start > Programs > WinRunner > WinRunner.
Using a Local Network Drive for Updates

You can download WinRunner installation updates from the Mercury Web site to a network drive and then access the local network drive for all WinRunner installations in your organization.

To download updates to a local network drive:

1  Insert the CD-ROM into the CD drive and run `<CD drive>\update.exe`. The Download Updates screen opens.
2  Choose the local network drive for the WinRunner update files and click Next.

Setup begins to download the files. When the download is complete, the Updates Download Complete screen opens.
Note: When you run update.exe, the program downloads all posted updates, regardless of their content and versions. When installing updates from a local network drive during the WinRunner installation, however, the setup program downloads in the same way as it downloads from the Web site. It installs only those features that are part of the current installation and are newer than the features on the CD-ROM.

3 Click Finish. After the updates are downloaded to a local network drive, you can link to that drive from the WinRunner installation to download the updates locally.

To download updates from a local network drive during a WinRunner installation:

1 When the Update Features screen of the WinRunner installation opens, select Use local update folder.

The Select Downloaded Updates Path screen opens.
2 To choose a different path, click the **Browse** button and select the path where the updates are stored. Click **Next**.

The installation program checks the specified network folder for updated features. If there are features in the update folder that are newer than the features on the CD-ROM, setup prompts you to overwrite the CD-ROM features with the update folder features. When the check is complete, the installation program continues as described in step 11 on page 21.
Setting Up a Silent Installation

You can run the WinRunner setup application silently on your computer. This means that the entire setup process runs in the background without requiring you to navigate through the setup screens. Before you run a silent installation, you (or the system administrator) must record the installation preferences of a standalone WinRunner installation on a computer with an identical computer configuration. Your silent installation will install an exact copy of the recorded configuration.

Recording a Standalone Installation

You record your standalone installation on a computer with a configuration that is identical to the computer(s) that will later run the silent installation. The computer configuration must include:

➤ identical operating systems
➤ same drive letter for installation files

In addition, neither computer should have WinRunner installed prior to running the silent installation.

Note: If either computer already has WinRunner installed, you should uninstall WinRunner before beginning the silent installation process to ensure that both computers have identical configurations.

If you want to download installation updates from the Web, you should follow the instructions in “Using a Local Network Drive for Updates” on page 32 before recording your standalone installation.

To record a standalone installation:

1 Copy the contents of the WinRunner installation CD to a shared folder on a network computer (<Shared_CD_Fldr>).
Installing WinRunner

2 Choose **Start > Run** from the computer on which you want to record the installation (the recording computer) and enter the command line to begin the installation:

➤ If you are installing WinRunner with a seat license, enter:
   `<Shared_CD_Fldr>\setup\setup.exe -r`.

➤ If you are installing WinRunner with a concurrent license, enter:
   `<Shared_CD_Fldr>\setup\english\setup.exe LICENSE_FLOATING -r`

3 Click **OK**. The WinRunner installation begins. For information on how to install WinRunner, see “Running a Standalone or Network Installation” on page 11. While recording your installation:

➤ In the installation type screen, select **Standalone Installation**.

➤ For any screens requiring a destination folder, be sure to choose a drive letter that all silent installation users have mapped correctly on their computer. If the destination folder you choose already exists on your computer, be sure that it exists for all silent installation users. If the folder you choose is a new folder, be sure that it is a new folder for all users.

➤ In the Update Features screen, select **No** or select **Use local update folder** if you already downloaded updated features to a local folder. (If you select **Yes** to connect and download from the Web while recording the installation, the silent installation user will be required to respond to certain dialog boxes and Web pages, so the installation will not be entirely silent.)

➤ In the Customer Registration screen, clear the **Register now** check box. Register at the Mercury Customer Support Web site at another time. (If you select the **Register now** check box, the silent installation user will be required to respond to certain dialog boxes and Web pages, so the installation will not be entirely silent.)

➤ In the Setup Complete screen, it is recommended to select **Yes, I want to restart my computer now** to assure that the silent installation will conclude with a restart on users’ computers to properly complete the installation process.

4 After restarting your computer, copy the **setup.iss** file from the Windows folder of the recording computer to `<Shared_CD_Fldr>\setup\english`. 
Running a Silent Installation

You can run a silent installation of WinRunner based on a recorded standalone installation. This enables you to install WinRunner on your computer with the identical installation options and features as the recorded installation without having to navigate through the installation screens.

To run a silent installation:

1. It is recommended to save any open files and close all open applications before running the silent installation.

Important Note: Your computer automatically shuts down and restarts at the end of the silent installation if the recorded installation includes the Yes, I want to restart my computer now option at the end of the installation process as recommended.

2. Choose Start > Run on the computer on which you want to install WinRunner silently and enter the silent installation command line:

   - For seat licenses, enter: 
     `<Shared_CD_Fldr>\setup\setup.exe -s.`
   - For concurrent licenses, enter: 
     `<Shared_CD_Fldr>\setup\english\setup.exe LICENSE_FLOATING -s`

3. Click OK. The installation begins to run in the background. The installation will take several minutes. During the installation, the following message is displayed:

   ![WinRunner Installation](image)

   The WinRunner silent installation is in progress.
Installing WinRunner

4 When the silent installation is complete, the message box closes.

➤ If the recorded installation includes the Yes, I want to restart my computer now option at the end of the installation process (recommended), then your computer automatically restarts when the silent installation is complete.

➤ If the recorded installation includes the No, I will restart my computer later option at the end of the installation process, then the WinRunner program group window opens displaying the WinRunner program icons when the silent installation is complete.

➤ If the WinRunner program group window opens, then you must restart your computer manually before using WinRunner. If you try to start WinRunner before restarting your computer, WinRunner will not run properly.

➤ If the silent installation message closes, but your computer does not restart and the WinRunner program group does not open, then your silent installation was not successful. For more information, contact your system administrator or see “Troubleshooting Silent Installation Problems” below.

Troubleshooting Silent Installation Problems

The silent installation option requires that the computer on which the installation is recorded and all computers running the silent installation have identical configurations. If one or more of the configuration elements differ, the silent installation stops running without completing the installation process.

If a silent installation fails, check the following:

➤ Did the recording computer or the silent installation computer have WinRunner installed prior to the installation?

If the recording computer and the silent installation computer have different configurations of WinRunner, the silent installation fails. In this case, the silent installation in progress message closes almost immediately after it opens.
Installing WinRunner

If either computer already has WinRunner installed, you should uninstall WinRunner before beginning the silent installation process to ensure that both computers have identical configurations.

➤ **Does the silent installation computer have the same drive letter(s) as those that the recording computer used for destination folders?**

During the silent installation, the setup program attempts to install WinRunner files in the paths selected by the recording computer. If the silent installation computer does not have the same drives available, the silent installation fails.

➤ **Do the selected destination folders exist on one computer and not on the other?**

When you select a new destination folder, the setup program asks you if you want to create the new folder. When you select an existing folder, the setup program does not create a new folder. If the new folder message is necessary for one computer and not for the other, the silent installation fails.

➤ **Are both computers running on the same operating system?**

If only one of the computers requires a special step due to the operating system being used, the silent installation fails.

➤ **Did you select Yes (selected by default) in the Update Features screen or Register now (selected by default) in the Customer Registration screen while recording the installation?**

These options will require input from the user. Therefore, the installation will not be silent. When you record the installation, it is recommended to select No or Use local update folder in the Update Features screen and to clear the Register now check box in the Customer Registration screen.

➤ **Did you restart the silent installation computer before running WinRunner?**

If the silent installation computer did not restart automatically at the end of the installation process, or if the user did not restart the computer manually prior to running WinRunner, WinRunner will not run properly.

If you have checked all of the issues described in this troubleshooting section and you are still unable to perform the silent installation successfully, contact Mercury Customer Support.
Modifying DCOM Permissions to Enable Remote WinRunner Execution

If you want to run WinRunner tests remotely from Quality Center, you must first change DCOM permissions and security settings and open a firewall port on your WinRunner computer. You can make these changes automatically or manually. If you do not intend to run WinRunner tests remotely from Quality Center, you do not need to make these changes. These changes are only required if you are running WinRunner on Windows XP Service Pack 2 or later, Windows 2003 Server Service Pack 1 or later, or Windows Vista.

This section describes:

➤ “Enabling Windows to Authenticate Remote Users” on page 41
➤ “Modifying DCOM Permissions and Security Properties Automatically” on page 41
➤ “Modifying DCOM Permissions and Security Properties Manually” on page 42

Note: The security changes described in this section should be performed by your System Administrator. Contact Microsoft Support if you have questions regarding changes in DCOM securities on Windows XP, Windows 2003 Server, or Windows Vista.

In addition to following the procedures below, before remotely running a test, you must also make sure that the Allow other Mercury products to run tests remotely option is selected in the Run category of the General Options dialog box in WinRunner. For more information, refer to the Mercury WinRunner User’s Guide.
Enabling Windows to Authenticate Remote Users

This procedure enables Windows to authenticate the remote user executing tests against the DCOM objects.

To enable Windows to authenticate the remote user:

1. Add both machines to the same domain.
2. For domain users logged into both machines, add these domain users to the Local Administrators group on the WinRunner computer.

Modifying DCOM Permissions and Security Properties Automatically

This procedure describes how to automatically set DCOM permissions and open firewall ports to enable remote execution of WinRunner.

---

**Note:** For more information about the changes that WinRunner makes when you choose to set these options automatically, refer to the steps described in “Modifying DCOM Permissions and Security Properties Manually” on page 42.

---

To modify DCOM permissions and security properties automatically:

1. After installing WinRunner, insert the WinRunner Installation CD-ROM into your CD-ROM drive. If the CD drive is on your local computer, the WinRunner Installation window opens.

   If you are installing from a network drive, connect to the drive and double-click `autorun.exe` under the `\setup` subdirectory. The WinRunner Installation window opens.

2. Click **Browse this CD** to show the CD contents.

3. Open the `dcom` folder and double-click `WRRmtAgentFix.exe`. The DCOM permissions and security settings are set automatically and the firewall port on your computer is opened to enable remote WinRunner execution. A progress bar is shown during the process.
Installing WinRunner

When the process is complete, a message opens indicating that the DCOM settings were changed successfully. If any errors occurred during the configuration, a message indicates the path to the configuration log file.

4 Click OK.

Modifying DCOM Permissions and Security Properties Manually

This section describes how to manually set DCOM permissions and open firewall ports to enable remote execution of WinRunner.

To configure the Windows Firewall to enable port 135 for DCOM:

Note: If you disabled the firewall installed with Windows XP Service Pack 2, Windows 2003 Server, or Windows Vista, you do not need to open port 135 for DCOM, as described in this procedure.

1 On the WinRunner computer, choose Start > Settings > Control Panel > Windows Firewall. The Windows Firewall dialog box opens.

2 Select the Exceptions tab.

3 Click Add Program. The Add a Program dialog box opens.

4 Select or browse to the Remote Agent (<WinRunner installation>\arch\wrrmtsrv.exe) and click OK.

Note: If you do not configure the Remote Agent as an exception as described above, a Windows Security Alert message will appear while running a test remotely. Click Unblock to solve this problem. The next time you remotely execute an automated test, the warning will not appear.
5 Click OK to close the Windows Firewall dialog box.

Note: For more information, a list of port assignments for commonly-used services can be found at:

To modify DCOM security properties:

1 Choose Start > Run, type dcomcnfg, and press ENTER. The Component Services window opens.

2 Navigate to Console Root > Component Services > Computers > My Computer.

Note: If a Windows Security Alert message opens, click Ask me later or Unblock.

3 Right-click My Computer and select Properties.

4 Select the Default Properties tab.

5 Make sure the Default Impersonation Level is Identify and click Apply.

6 Select the COM Security tab.

7 In the Access Permissions area, click Edit Limits. The Access Permission dialog box opens.

8 Click Add. The Select Users or Groups dialog box opens.

9 Click Advanced.

10 Click Locations. In the displayed dialog box, select your computer name and click OK.

11 Click Find Now.
Installing WinRunner

12 Select the following users and groups from the local machine and click OK:
   ➤ Administrator
   ➤ Administrators
   ➤ Authenticated Users
   ➤ Anonymous Logon
   ➤ Everyone
   ➤ Interactive
   ➤ Network
   ➤ System

13 Add the following users from the domain and click OK:
   ➤ <domain user logged into the WinRunner computer>
   ➤ <domain user logged into the Quality Center computer that is performing the remote execution>

14 In the Access Permission dialog box, assign Local Access and Remote Access permissions to the groups and users in the list and click OK.

15 In the Launch and Activation Permissions area, click Edit Limits. The Launch Permission dialog box opens.

16 Repeat steps 8 to 13.

17 In the Access Permission dialog box, assign Local Launch, Remote Launch, Local Activation, and Remote Activation permissions to the groups and users in the list and click OK.
To configure security settings for the WinRunner Remote Agent DCOM applications:

1. In the Component Services window, navigate to Console Root > Component Services > Computers > My Computer > DCOM Config.

2. Right-click the \{0B171F02-F204-11D0-9398-0080C837F11F\} item and select Properties. The \{0B171F02-F204-11D0-9398-0080C837F11F\} Properties dialog box opens.

3. In the Identity tab, select The interactive user. This enables the DCOM application to authenticate the process against the logged-in Windows user and run the process in that security context.

4. Select the Security tab.

5. In the Launch and Activation Permissions area, select Customize and click Edit. The Launch Permission dialog box opens.

6. Click Add. The Select Users or Groups dialog box opens.

7. Click Advanced.

8. Click Locations. In the displayed dialog box, select your computer name and click OK.

9. Click Find Now.

10. Select the following users and groups from the local machine and click OK:
    - Administrator
    - Administrators
    - Authenticated Users
    - Anonymous Logon
    - Everyone
    - Interactive
    - Network
    - System
11 Add the following users from the domain and click OK:
   ➤ <domain user logged into the WinRunner computer>
   ➤ <domain user logged into the Quality Center computer that is performing the remote execution>

12 In the Launch Permission dialog box, for all the groups and users in the list, select Allow for all permissions and click OK.

13 In the Access Permissions area, select Customize and click Edit. The Access Permission dialog box opens.

14 Repeat steps 6 to 12.

15 Click Apply to save the changes and click OK to close the dialog box.

16 Close the Component Services window.

You can now remotely execute a WinRunner test from Quality Center.

---

**Note:** Before remotely running a test, you must also make sure that the **Allow other Mercury products to run tests remotely** option is selected in the **Run** category of the General Options dialog box in WinRunner. For more information, refer to the *Mercury WinRunner User’s Guide.*
Modifying User Account Control Settings to Connect with Quality Center on Windows Vista

If you are running WinRunner on Windows Vista, you must disable User Account Control (UAC) before you connect to Quality Center for the first time. After you have connected to Quality Center, you can enable User Account Control (UAC) again if required.

This change is required only if you are running WinRunner on Windows Vista, and if you intend to run WinRunner tests remotely from Quality Center on that WinRunner client. Otherwise, you do not need to make these changes.

Note: The security changes described in this section should be performed by your System Administrator. Please contact Microsoft Support if you have questions regarding changes in User Account Control (UAC) on Windows Vista.

To disable User Account Control (UAC) on Windows Vista:

1 Choose Start > Settings > Control Panel > User Accounts.
2 Click the Change Security Settings option.
3 Clear the Use User Account Control (UAC) to help protect your computer check box.
4 Click OK.
You can install WinRunner with a seat license or a concurrent license.

When you install WinRunner with a seat license for the first time on a computer, it includes an automatic 14-day demo license. During this time period, you must contact Mercury’s Customer Support Organization to obtain a permanent license for your computer.

**Note:** You cannot use a demo license on a computer that has WinRunner or QuickTest installed using a concurrent license.

This section describes:

- About Working with WinRunner Licenses
- Understanding Your WinRunner License
- Installing WinRunner Licenses
- Requesting a Seat License Code
- Activating a Seat License Code
- Changing the License Type
- Setting the LHOST or LSFORCEHOST Variable
- Working with Commuter Licenses
About Working with WinRunner Licenses

When you start WinRunner for the first time after installing a seat license, you receive a warning that the demo license will expire within 14 days. Until you install a permanent license, each time you start WinRunner, you will receive a warning indicating how many days are left before your demo license expires.

You can request and activate a seat license from the Help menu or directly from the warning you receive when starting WinRunner.

Note for previous WinRunner local license users: If you are upgrading from WinRunner 7.5 (or from WinRunner 7.01 for European customers), you can continue to use your existing license code. For earlier versions of WinRunner, you must request a license code from Mercury Customer Support and activate the license code before starting WinRunner. When a message box is displayed after you try to start WinRunner, click the Install License button to continue.

When you install WinRunner with a concurrent license, you do not have a 14-day demo period. Before running WinRunner with a concurrent license, the concurrent license server must be installed and running and the concurrent license code must already be activated. For more information, refer to the Mercury Functional Testing Concurrent License Server Installation Guide.

When you start WinRunner after installing a concurrent license, WinRunner automatically finds and connects to the concurrent license server. You usually do not need to do anything on your WinRunner computer to enable the license. If the Mercury Functional Testing Concurrent License Server is installed, but your computer cannot automatically find and connect to it, you may need to set the LSHOST or LSFORCEHOST variable on your computer.

If you are working with a concurrent license, you can take advantage of commuter licenses, which enable you to temporarily use a WinRunner concurrent license on a computer that is not connected to the network.
Understanding Your WinRunner License

To use WinRunner, you must have a valid license. There are two types of licenses: seat (formerly known as local or standalone) and concurrent (formerly known as floating). The table below summarizes the differences between the two license types.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Seat License</th>
<th>Concurrent License</th>
</tr>
</thead>
<tbody>
<tr>
<td>General description</td>
<td>The license is specific to the computer on which it is installed.</td>
<td>Each license entitles the organization to one additional concurrent user.</td>
</tr>
<tr>
<td>Number of installations per license code</td>
<td>Each installation of WinRunner requires a distinct license code.</td>
<td>There is no limit to the number of WinRunner installations on the network, but a special license server regulates the number of computers that can run a copy of WinRunner at any time.</td>
</tr>
<tr>
<td>Demo license</td>
<td>The installation includes a 14-day demo license. You must request and activate a license code during the 14 days.</td>
<td>The installation does not include a demo license. You must request and activate the license code on the license server before you can use WinRunner.</td>
</tr>
<tr>
<td>Maintenance number</td>
<td>The license code is based partially on the maintenance number. The maintenance number identifies the customer.</td>
<td>The license code is based partially on the maintenance number. The maintenance number identifies the customer and indicates how many concurrent users the license will support.</td>
</tr>
</tbody>
</table>
Note that the license type and installation type are not co-dependent: you can install WinRunner using any installation type, regardless of the license type you choose and vice versa. For more information on installation types, see “Choosing the Installation and License Type” on page 8.
Installing WinRunner Licenses

The general procedure for installing WinRunner and activating the license differs for seat license installations and concurrent license installations. This section summarizes these procedures for the two license types and directs you to the detailed information for each step.

To install WinRunner with a seat license:

1. Run the WinRunner setup program (autorun.exe). If you are installing a standalone or network installation for the first time, select Seat License in the license type screen. For more information and step-by-step instructions, see “Running a Standalone or Network Installation” on page 11, or “Running a Workstation Installation” on page 30.

2. Run WinRunner using the 14-day demo license.

3. Request your seat license code. For more information, see “Requesting a Seat License Code” on page 53.

4. After you receive the license code from Mercury, enter the code to activate your license. For more information, see “Activating a Seat License Code” on page 55.

5. If you plan to test Visual Basic applications, and/or ActiveX table objects, configure your application as described in “Configuring Visual Basic Support” on page 75, and “Enabling Table Contents Checks for an ActiveX Control” on page 77.

To install WinRunner with a concurrent license:

1. Insert the Mercury Functional Testing Concurrent License Server CD-ROM and install the concurrent license server using the on a network computer with a fixed IP address. For more information and step-by-step instructions, refer to the Mercury Functional Testing Concurrent License Server Installation Guide.

2. Request your concurrent license code. For more information, refer to the Mercury Functional Testing Concurrent License Server Installation Guide.

3. Once you receive the concurrent license code from Mercury, enter the code to activate your license on the license server. For more information, refer to the Mercury Functional Testing Concurrent License Server Installation Guide.
Insert the WinRunner CD-ROM and run the WinRunner setup program (`autorun.exe`). If you are installing a standalone or network installation for the first time, select **Concurrent License** in the license type screen. For more information and step-by-step instructions, see “Running a Standalone or Network Installation” on page 11, or “Running a Workstation Installation” on page 30.

If you plan to test Visual Basic applications, and/or ActiveX table objects, configure your application as described in “Configuring Visual Basic Support” on page 75 and “Enabling Table Contents Checks for an ActiveX Control” on page 77.

Begin using WinRunner. When WinRunner opens, it will automatically find the license server and connect to it.

---

**Note:** For more information and answers to common license code questions, browse to [http://kb-web.mercury.com/license.html](http://kb-web.mercury.com/license.html).

---

**Requesting a Seat License Code**

When you install WinRunner with a seat license for the first time, it includes an automatic 14-day demo license. To use WinRunner beyond the 14-day period, you must request and activate a license code for your copy of WinRunner.

**To request a seat license:**

1. Perform one of the following:
   - From the warning message displayed when you start WinRunner, click **Install License**.
   - From within WinRunner, choose **Help > Licence > Install Software License**.

The WinRunner License Installation program starts, and the Welcome screen opens, displaying the locking code for your computer, the license type, and the WinRunner maintenance number that you entered when you installed WinRunner.
Note that there is a single maintenance number for each team of users. (The maintenance number identifies the customer and replaces what was formerly a serial number for each purchased copy of WinRunner.)

2 Use the Web site displayed in the screen to send the locking code, license type, and maintenance number to Mercury Customer Support. Note that you can copy and paste the information from the Welcome screen into the license request form at the Mercury Customer Support Web site or into an e-mail message.

Note: If you do not have Web access from the computer where you are installing WinRunner, you can send an e-mail containing your computer locking code, the license type, and your maintenance number to Customer Support.
3 If you already have your license code, click **Next** to begin the license activation process, and proceed to step of “Activating a Seat License Code” on page 57. Otherwise, click **Cancel** and wait for your license code to arrive. When it arrives, follow the instructions for activating a seat license code as described below.

**Activating a Seat License Code**

After you receive your license code from Mercury, you must run the WinRunner License Installation again to activate the code.

**To activate your seat license code:**

1 Perform one of the following:
   - From the warning message displayed when you start WinRunner, click **Install License**.
   - From within WinRunner, choose **Help > License > Install Software License**.
The WinRunner License Installation program starts and the WinRunner License Installation - License Type screen opens.

2 Choose **Seat license** and click **Next**. The Welcome Screen opens and displays the locking code for your computer, the license type, and the WinRunner maintenance number that you entered when you installed WinRunner.
3 In the Welcome screen, click **Next** to continue.

![Image of WinRunner License Installation Welcome screen]

The WR-core License Installation screen opens recommending that you exit all Windows programs.
4 Click **Next**. The User Information screen opens.

Enter your first name, last name, and company name in the appropriate boxes. In the **Maintenance Number** box, enter your maintenance number, which you received from Mercury when you purchased WinRunner. This number can be found in the Maintenance Pack Number envelope or on the bill of lading. There is a single maintenance number for each team of users. The maintenance number replaces what was formerly a serial number for each purchased copy of WinRunner. The maintenance number, which identifies the customer, determines the license type.
5 Click **Next**. The Details screen opens.

![License Installation - Details](image)

Verify that the information on the WinRunner License Installation screen is correct and insert the license code provided by Mercury’s Customer Support Organization into the **License Code** box. Note that the license code is valid only for the computer with the locking code that you entered in the license request form.

6 Click **Next**. If you entered a valid license code, the Status screen confirms that your license code was successfully installed.

7 Click **Next**. The Finished screen opens and displays customer support information.

8 Click **Finish** to complete the license activation process.

---

**Note:** For more information and answers to common license code questions, browse to [http://kb-web.mercury.com/license.html](http://kb-web.mercury.com/license.html).
Changing the License Type

You can change your WinRunner license type from seat to concurrent or from concurrent to seat.

To change your license type:

1 Ensure that you are logged in to your computer with administrator privileges.
2 In WinRunner, choose Help > License > Change License Type. The License Type opens.

3 Change your license type and click Next or click Cancel to continue using the existing license type.

You must restart WinRunner for the change in license type to take effect.
If you change your license type from concurrent to seat, you need to request and activate the seat license code. For more information, see “Requesting a Seat License Code” on page 53 and “Activating a Seat License Code” on page 55.

If you mistakenly changed your license type from seat to concurrent, but there is no concurrent license server installed and running on your network, the next time you start WinRunner, a warning message opens. Click Install License in the warning message to change your license type back to seat.

**Setting the LSHOST or LSFORCEHOST Variable**

You set the LSHOST or LSFORCEHOST variable to enable QuickTest or WinRunner to search for a specific Mercury Functional Testing Concurrent License Server on the network. The LSHOST variable sets the preferred concurrent license server for a QuickTest or WinRunner client. If the specified concurrent license server cannot be found, then a search is conducted on the entire network. The LSFORCEHOST variable restricts QuickTest or WinRunner to a specific concurrent license server.

You may need to set the LSHOST or LSFORCEHOST variable if the Mercury Functional Testing Concurrent License Server is installed on a different subnet than the WinRunner client.

**To set the LSHOST or LSFORCEHOST variables:**

2. Click the Advanced tab.
3. Click the Environment Variables button. The Environment Variables dialog box opens.
4. In the User Variables for <user name> list, click New. The New User Variable dialog box opens.
5. In the Variable Name box, type LSHOST or LSFORCEHOST.
6. In the Variable Value box, type the full name of the license server. Alternatively, you may enter the IP address of the host computer.
Working with WinRunner Licenses

For multiple host names (for example, if there are several Mercury Functional Testing Concurrent License Servers running on one network), use a semicolon (;) to separate the hosts’ names or IP addresses in the Variable Value box.

7 Click **OK** to close the New User Variable dialog box.

8 Under **System variables**, click **New**. The New System Variable dialog box opens.

9 Repeat steps 5 and 6.

10 Click **OK** to close the New System Variable dialog box.

11 Click **OK** to close the Environment Variables dialog box.

12 Click **OK** to close the System Properties dialog box.
**Working with Commuter Licenses**

Commuter licensing enables concurrent license users to temporarily use a WinRunner concurrent license (up to 30 days) on a computer that is not connected to the network (and therefore cannot obtain a concurrent license from the license server in the regular way). For example, suppose you need to travel on business with your laptop computer and you want to use WinRunner while you are away. You can check out a WinRunner license from the concurrent license server to use for the duration of your trip, and then check the license back in upon your return.

If you are unable to check out a license before you disconnect from the network, or if you checked out a commuter license but it expired, for example, because your return from your trip was delayed, you can ask a local network user to check out a commuter license and send it to you remotely. For more information, see “Obtaining a Commuter License Remotely” on page 68.

Commuter licenses are useful when:

➤ You want to use WinRunner from home, while traveling, or any other time when you cannot connect to the network.

➤ You must ensure that a license will be available to you 24 hours a day and you cannot risk other server users using up the available concurrent licenses.

➤ You want to work with a demo license for an add-in. (Add-in demo licenses can be used only with a seat or commuter license).

---

**Note:** Commuter licensing is supported by Mercury Functional Testing Concurrent License Server version 7.6 and later. If you have upgraded to Mercury Functional Testing Concurrent License Server 8.0 from a version earlier than 7.6, you need to request a new server license code to enable the commuter licensing functionality. For details, contact Mercury Customer Support or your local representative.
Checking Out a Commuter License

Before you check out a commuter license, ensure that the computer (for example, a laptop) on which you want to install the commuter license has WinRunner installed, is connected to the network, and has access to a license server with an available WinRunner license. After you have checked out the license, you can disconnect the computer from the network.

If you need a commuter license when you do not have access to the network, you can ask a local network user to check out a commuter license and send it to you remotely. For more information, see “Obtaining a Commuter License Remotely” on page 68.

Note: Do not modify the date or time on a computer to which a commuter license is currently checked out.
To check out a commuter license:

1. Run the `WCommute.exe` file located in `<WinRunner installation folder>\arch`. The Commuter Licensing dialog box opens.

2. To see commuter licenses available on all license servers located within your subnet, click **Search Subnet**. If there is a specific license server you want to use, or you want to select a license server outside of your subnet, click **Single Server**.

   - If you clicked **Search Subnet**, the WCommute utility searches the subnet for license servers that support commuter licensing and displays them in the Commuter Licensing dialog box. Note that this process may take several minutes.

   - If you clicked **Single Server**, a dialog box opens for you to specify the license server you want to locate. Enter the license server computer's host name, IP address, or IPX address and click OK. The specified license server is located and displayed in the Commuter Licensing dialog box.
For each license server, a list of commuter licenses available to check out is displayed. A red check mark next to a commuter license means that you have already checked out that license to your computer. You cannot check out multiple licenses for the same application to the same computer.

3 Select the license that you want to check out.

4 In the **Please enter the number of days until the authorization expires** box, specify the maximum number of days to check out the license (up to a maximum of 30 days).

**Note:** When you check out a license, it decreases the number of licenses available for use by others. Therefore, you should specify the minimum number of days that you require.

5 Click **Check Out**. The selected license is saved locally on your computer.

6 To use the new checked-out license, open WinRunner and change your license type from concurrent to seat. For more information, see “Changing the License Type” on page 60.

**Checking In a Commuter License**

When you have finished using the commuter license, you should check it in from your computer to the license server from which you checked it out. This makes the license available to other users.

**Note:** If your license has expired, you do not need to check it in. Once a license expires, you cannot use it and it is automatically returned to the license server, even if your computer is not connected to the license server network.
To check in a commuter license:

1 Run the `WCommute.exe` file located in `<WinRunner installation folder>`\arch. The Commuter Licensing dialog box is displayed.

2 Locate the license server for the commuter license you want to check in, as described in step 2 of “Checking Out a Commuter License” on page 65. You must check in the license to the same license server from which you checked it out.

3 Select the license you previously checked out.

**Tip:** The checked-out license is indicated by a red check mark.
Click **Check In**. The license is returned to the license server, and is made available for use by others. To use WinRunner again, you must first change your license type from seat to concurrent. For more information, see “Changing the License Type” on page 60.

**Obtaining a Commuter License Remotely**

Remote commuter licensing enables a local network user to locally check out a WinRunner commuter license and send it to you for installation on a remote computer. This is useful in situations where you are currently not connected to the license server network (for example, you may be out of the office on an extended business trip), but need to be able to use WinRunner.

**Note:** Do not modify the date or time on a computer to which a commuter license is currently checked out.

The following procedure summarizes the process of obtaining a commuter license remotely.

**To obtain a commuter license remotely:**

1. Run the WRCommute utility to generate a commuter locking code for your computer and send the commuter locking code to a local user who has access to the Mercury Functional Testing Concurrent License Server. For more information, see “Generating a Remote Computer Locking Code” on page 69.

2. Ask the local user to run the WCommute utility (entering the commuter locking code you generated) to check out a remote commuter license, and send it to you. For more information, see “Checking Out a Commuter License for a Remote Computer” on page 70.

3. Run the WRCommute utility to install the remote commuter license on your computer. For more information, see “Installing a Commuter License on a Remote Computer” on page 73.

4. Open WinRunner and change your license type from concurrent to seat. For more information, see “Changing the License Type” on page 60.
Generating a Remote Computer Locking Code

The first step in remotely obtaining a commuter license is to generate a locking code on your computer and transfer it (by e-mail) to a network user who has access to the license server.

**Note:** The remote computer locking code used to lock a commuter license is not the same as the locking code displayed by the ECHOID utility. You must use the WRCommute utility to obtain the commuter license locking code.

To generate a locking code on a remote computer:

1. Run the `WRCommute.exe` file located in `<WinRunner installation folder>\arch`. The WRCommute dialog box is displayed.

   ![WRCommute Dialog Box]

   The **Locking code string for the current machine** box contains the locking code that you need to e-mail to a network user who has access to the license server containing the WinRunner licenses.
Send the locking code to the local network user in one of the following ways:

➤ Select the locking code string and click the Copy button to copy the string to your Windows clipboard. Then open your e-mail program and paste the string into a new e-mail message and e-mail it to the local network user.

➤ Click the Save button to save the locking code in a file. Specify the name and location for the file, and then attach the file to a new e-mail message and e-mail it to the local network user.

➤ Click the Display button to display the entire locking code in another dialog box. You can then select the locking code string, right-click it and select Copy to copy it to your Windows clipboard. Then open your e-mail program and paste the string into a new e-mail message and e-mail it to the local network user.

➤ In the E-mail address box, enter the e-mail address of the local network user and click Send. Note that this option is supported only if Microsoft Outlook Express is set up as your e-mail client.

**Checking Out a Commuter License for a Remote Computer**

The next step in remotely obtaining a commuter license is for a local network user to check out the license, and then transfer it to you (by e-mail).

---

**Note:** The following procedure can be performed only by a local network user who has WinRunner installed on his or her computer and also has access to the license server that contains the WinRunner license.
To check out a commuter license for a remote computer:

1 Run the **WCommute.exe** file located in `<WinRunner installation folder>\arch`. The Commuter Licensing dialog box is displayed.

![Commuter Licensing dialog box](image)

2 Locate the license server from which you want to check out a remote commuter license, as described in step 2 of “Checking Out a Commuter License” on page 65.

For each license server, a list of commuter licenses that you can check out is displayed.

3 Select the license that you want to check out.

4 Select the **Check out authorization for remote machine** check box.
5 Click Check Out. The Locking Code for Remote Machine dialog box opens.

![Locking Code for Remote Machine dialog box]

6 Enter the locking code that the remote user e-mailed you in one of the following ways:

- If the locking code was e-mailed to you in the body of an e-mail, copy it to your Windows clipboard. In the Locking Code for Remote Machine dialog box, select Enter the locking code string for remote machine and then click the Paste button.

- If the locking code was e-mailed to you as an attached file, save the attachment and then select Get locking code string for remote machine from file. Click the Load button. Select the file that contains the locking code and click Open.

7 Click OK. The Remote Commuter Licensing dialog box opens.

![Remote Commuter Licensing dialog box]
Send the commuter license to the remote user in one of the following ways:

➤ Click the Save button to save the locking code in a file. Specify the name and location for the file, click Save and then click OK. Attach the file to a new e-mail message and e-mail it to the remote user.

➤ In the E-mail address box, enter the e-mail address of the remote user. Click Send and then click OK. Note that this option is only supported if Microsoft Outlook Express is set up as your e-mail client.

Installing a Commuter License on a Remote Computer

The final step in remotely obtaining a commuter license is to install the license that was sent to you by the network user on your computer.

To install a commuter license on a remote computer:

1 Ensure that you are logged in to your computer with administrator privileges.

2 Run the WRCommute.exe file located in <WinRunner installation folder>\arch. The WRCommute dialog box is displayed.

3 Click the Install Remote Authorization Code tab.
4 Enter the commuter license that the network user e-mailed you in one of the following ways:

➤ If the commuter license was e-mailed to you in the body of an e-mail, copy it to your Windows clipboard. In the Install Remote Authorization Code tab of the WRCommute dialog box, select Enter remote authorization code and then click the Paste button.

➤ If the commuter license was e-mailed to you as an attached file, save the attachment and then select Get remote authorization code(s) from file. Click the Load button, select the file that contains the locking code, and click Open.

5 Click Install. The new license code is installed on your computer.

6 Open WinRunner and change your license type from concurrent to seat. For more information, see “Changing the License Type” on page 60.

Note: A remote commuter license cannot be checked in to the license server when you have finished using it—it simply expires on the remote computer. After you return to your office and are reconnected to the network, you should change your license type from seat to concurrent. For more information, see “Changing the License Type” on page 60.
Configuring Visual Basic Support

When working with Visual Basic 6.0 applications, you do not need to configure your Visual Basic application.

Before you can start testing a Visual Basic 5.0 application using WinRunner's add-in support for Visual Basic, you (or the application developer) must configure the Visual Basic application you want to test.

Note: In versions of WinRunner prior to version 7.6, you were also required to configure your Visual Basic 6.0 applications. In WinRunner 7.6 and later, there is no need to configure your Visual Basic 6.0 application. If, however, you have already added the WinRunner agent to your Visual Basic 6.0 application for use with previous versions of WinRunner, there is no need to remove it.

Configuring Visual Basic 5.0 Support

Before you can start using WinRunner's add-in support for Visual Basic 5.0 applications, you must add the WinRunner agent to your application.

To configure support for your Visual Basic 5.0 application:

1. If your application currently references the WinRunner OCX, you must first remove all references from forms, as well as the associated code (Wrb1.Init Forms).

2. Add the WinRunner agent to the application by running the setup.exe program from the \vbdev directory on the WinRunner installation CD-ROM.
Configuring Visual Basic Support

The WinRunner agent installation installs an AddIn to your Visual Basic IDE. The name of this AddIn is **WinRunnerAddIn.Connect**. It adds lines of code to your Visual Basic source code as described below.

The WinRunnerAddIn.Connect AddIn:

➤ adds a reference to **wrvbasr.dll**
➤ adds a new code Module to the Visual Basic project called “WinRunnerSupport”
➤ adds a line to the WinRunnerSupport Module:
  ```vbnet
  Global asr As New WRVBASRLib.VbMod
  ```
➤ adds code to the StartUp object:
  If the Startup Object is a Form, the AddIn adds the following line of code to the Form_Load event:
  ```vbnet
  asr.Init Forms
  ```
  If the Startup Object is Sub Main, the AddIn adds the following line of code to the Main() method:
  ```vbnet
  asr.Init Forms
  ```
➤ For all Class modules in the project, the AddIn adds the following line of code to the Class_Initialize event:
  ```vbnet
  asr.Init Forms
  ```
➤ For all UserControl modules in the project, the AddIn adds the following line of code to the UserControl_Initialize event:
  ```vbnet
  asr.Init Forms, UserControl
  ```
➤ For all UserDocument modules in the project, the AddIn adds the following line of code to the UserControl_Initialize event:
  ```vbnet
  asr.Init Forms, UserDocument
  ```

**Notes:**

If the error message: **DllRegisterServer in <Windows directory>\system\wrvbasr.dll failed** is displayed during the WinRunner agent installation, copy the file **oleaut32.dll** (version 2.20.4054.1 or later) to your system directory and re-install the WinRunner agent.

Do not run WinRunner and the Visual Basic IDE together.

Test your application only as a running executable.
Enabling Table Contents Checks for an ActiveX Control

To enable support for table contents verification on any ActiveX control that can be viewed as a table object, you must implement a capture function for the ActiveX control in Visual Basic and then execute a TSL function.

WinRunner includes a Visual Basic project file (wrvbsrv5.vbp) that compile into an OLE Automation Server. WinRunner uses this server to capture table contents.

To enable contents verification on an ActiveX control that can be viewed as a table object:

1. Start Visual Basic 5.0/6.0.
2. In Visual Basic, open wrvbsrv5.vbp, located in the WinRunner installation folder under custom\wrvbsrv.
3. Open capture.cls and add a Sub-routine with the following prototype:

   Public Sub<CaptureFunctionName>(ByVal <tab_ctrl> As Object, ByVal <file_name> As String)

   The function should dump the table contents of the ActiveX control into <file_name> in the following format:
   cells separated by Tab(Chr(9)), rows separated by Newline.

   **Note:** Cell data should not contain escape characters such as tabs or new lines. Cells in the first row (column titles) should not contain escape characters or space characters. See the MSGridCapture Sub routine in the wrvbsrv project file for an example.
Enabling Table Contents Checks for an ActiveX Control

4 from the File menu select **Make WRVBRSRV DLL file**.

5 In WinRunner, execute the **add_table_capture_function** statement. Set the second argument to the name of the Sub you implemented in the Visual Basic function. For example:

```c
add_table_capture_function ("MSGrid.Grid", "MSGridCaptureFunc");
```
Configuring WinRunner to Work with Embedded Browser Controls

When working with embedded browser controls inside applications other than the Internet Explorer or Netscape browsers, you must specify the applications in `wrun.ini`.

To configure WinRunner to Work with Embedded Browser Controls:

1. Confirm that Microsoft Active Accessibility is installed.
2. Open `<WinRunner installation folder>\dat\wrun.ini` in a text editor.
3. Add a line to the `[ie_hooks]` section of `wrun.ini` for each application in the format: `<MyApp.exe>=yes`, where `<MyApp.exe>` is the name of your application.
Adding WinRunner Features

After you install WinRunner, you can run the setup program at any time to add program features, such as an additional development environment or control support, samples, or online documentation.

If you are unsure which options to select while adding program features, refer to the corresponding step in the “Installing WinRunner” section of this guide for more information.

To add features:

1. Insert the CD-ROM into the drive from which you want to add WinRunner features. If the CD drive is on your local machine, the WinRunner Setup window opens. If you are installing from a network drive, connect to it and run autorun.exe under the \setup subdirectory.

2. Click Install. The WinRunner setup program starts. The WinRunner Setup splash screen and the Setup progress bar open. The software license agreement opens.

3. Read the agreement. To accept the terms of the license agreement, click Yes. If you click No, the setup program will close. To install additional WinRunner features, you must accept the license agreement.

4. In the Registration Information dialog box, confirm that your name, the name of your company, and the WinRunner maintenance number are correct. Click Next to proceed.

5. Click Yes to confirm the registration information.

6. Select your installation type: Standalone Installation, Network Installation, or Network Installation and add shortcuts to your Start menu. Click Next to proceed.

7. Choose Custom. Click Next to proceed.

8. Select the features you want to install and specify the destination folder. The folder must be the WinRunner installation folder. Click Next to proceed.
Adding WinRunner Features

9 Select Yes, No, or Use local update folder to set your update features preferences. Click Next to proceed.

10 The Install/Reinstall Features screen opens.

```
Install/Reinstall Features
These features are already installed with the latest versions:
WinRunner
Unified Report
Samples
Online Documentation
WebTest
These features are already installed, but have newer versions:
ActiveX Controls 8.0 598.0
These features are not installed:
Visual Basic
PowerBuilder

Please select your installation options:
☐ Reinstall: all existing features
☐ Install all new features: only features with newer versions

OK Cancel
```

Select the Reinstall check box and decide whether to reinstall all existing features or only features with newer versions.

Select Install all new features to install features that are not yet installed.

11 If you chose Network Installation and add shortcuts to your Start menu in step 6, select a location for the local WinRunner folder. Click Next to proceed.

Note: If you are adding features to a network installation that has already been used for one or more network installations, you must uninstall WinRunner from the workstations and then run the workstation installation(s) again to update each workstation with the new features.

12 Select a location for temporary WinRunner files. Click Next to proceed.

13 Select a program folder for WinRunner icons. Click Next to proceed.
The installation settings you selected are displayed in a read-only window. Review the settings. If you want to select different settings, click Back. If you are satisfied with the settings, click Next.

The installation process begins.

To pause or quit the installation process, click Cancel.

Read the information about accessing online documentation. If you installed add-in support for Visual Basic applications, additional information appears on your screen. Click Next to proceed.

Read about the type of license you are using. Click Next. The installation process is complete.

Read the information about Mercury’s Customer Support. To register as a Mercury customer now, select the Register now check box. Mercury’s Customer Support Web site opens to the registration page. Click Next.

Choose whether or not to restart your computer and click Finish.

---

**Note:** It is strongly recommended that you restart your computer as soon as possible. Delaying the system restart could result in unexpected system behavior.
Uninstalling WinRunner

Your WinRunner installation includes an uninstall program that uninstalls WinRunner software and files from your computer and removes WinRunner shortcuts from your Start menu.

To uninstall WinRunner:

1. Click Programs > WinRunner > Uninstall WinRunner on your Start menu. Click Yes to confirm that you want to uninstall WinRunner.

2. The Uninstall Shield window opens. You may be prompted to remove shared files that are not in use by any other program. If you are not sure what to do, click No to All.

   The Uninstall program removes WinRunner from your computer.

3. When the Uninstall program is complete, the OK button is enabled. Click OK.

4. You must restart your computer to complete the uninstall process.

Note: If you try to reinstall WinRunner before restarting your computer, WinRunner may not be installed properly.
Uninstalling WinRunner